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Two Important Things to Know

Aurbach & Associates, Inc.

Welcome
Toot!® is versatile tool and, like a word processor, you can make many things with it. It
was designed for portfolios and for rich résumés and CVs. A rich résumé has lagniappe,
something extra — an artifact that shows what you can do, along with the chronicle of
your job history. It is important to us that your work with Toot! be productive and
fun. In addition to this booklet, check the online help; if we haven’t addressed your
question, please write to support@aurbach.com.

First: Create a New Portfolio
Do This
1. Run Toot!
2. Choose New on the
File menu.

3. Choose a template.

4. Choose a border color
and click OK to build
the portfolio.
5. Click Save on the
Save dialog.

Comments
There will be a shortcut or alias icon on your
desktop. Double-click it to run Toot!
The Create a New Portfolio wizard appears. On
the first panel, be sure to fill in Last Name, then
click the right arrow . Create as many portfolios
or résumés as you want.
Templates provide a structure of sections and
pages to help you get started quickly.
• New from Local Template offers some generic
templates in the window.
• New from Web Template offers templates for
many professions and one for homeschoolers.
Template borders vary in color; your choice here
affects only new pages you create in the portfolio.
If you don’t like the template border color, you
can change its color.
Toot! saves the portfolio as a .toot file in your
My Documents or Documents folder. It also
opens the portfolio. You are ready to start using
Toot!

⇑

Two Important Things to Know
Browse vs.
Design Mode

Templates
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The lower left corner of every page has a mode menu. Most
work — adding content, viewing the portfolio, etc., is done
in browse mode. To change page layout, add, remove,
align, or resize items place labels (prompts) on fields, and
set up table columns, use design mode.
If you download a template from www.aurbach.com, it
lands on your desktop. Place it in your My Documents or
Documents folder. When you create a New portfolio (File
Menu/New), it will be one of the Local templates. [More]
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Sections

Quick Three-Step Tutorial
Step
1. Build It

•

2. Fill It

•
•
•

3. Show It

•
•
•

Comments
Review the structure of sections and pages (use the
header menus); modify them for your needs.
Modify page layout for your needs.
Add content to the empty items the pages.
Reflect on each artifact.
If unsure about how to be reflective, look under
Reflection, Tips for in the Toot! program help.
The process of reflection enables learning in a
learning/teaching portfolio; a reflection is also the place
to guide a reviewer toward a proper appreciation of your
work if this is a résumé that you will be sending out.
Review your portfolio or résumé regularly; cull out-dated
work; add new artifacts.
Package your portfolio or résumé for email, burning to
CD/DVD to send out for review.
Convert it to HTML for posting on the web.

⇑

Sections
Sections organize the portfolio or résumé like dividers in a binder.
For Sections
Add a
new one

Within the Portfolio
On the Section menu in
the header, choose the last
item, Add a New Section.
Enter a section name and
a name for its first page.

Duplicate
it

Move /
Reorder it
Remove it
Rename it

Toot! Basics

Click the small pencil icon
at the left of the Section
menu in the page header.

800–774–7239

On the Portfolio Maintenance Panel
(See the Options Menu)
Select a Section on the tree. The new
section will be added just below it.
Click Add Section.
Enter a section name and a name for
its first page.
Select a section on the tree and click
Duplicate.
Rename the duplicate section and all
of its pages.
Drag the section to its new place on
the tree. It will carry all its pages
with it.
Select the section on the tree and
click Delete.
Select the section on the tree and
click Rename.

support@aurbach.com
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Pages

Aurbach & Associates, Inc.

Pages
A page is the basic unit of a Toot! portfolio. Every portfolio has at least one section
with one page.
For a Page
Add a
new one

Within the Portfolio
On the Page menu in the
header, choose the last
item, Add a New Page
and enter a name.

Duplicate
a page
Move
a page
Place items
on a Page
Remove
a page
Rename it

On the Portfolio Maintenance Panel
(See the Options Menu)
• Select the page on the tree just
above where you want the new page
to be.
• Click Add Page.
• Enter a name and click OK.
Select a page on the tree and click
Duplicate.
Rename the duplicate page.
Select a page on the tree and drag it
to its new place.

Switch to design mode
and drag items from the
to the page. See Layout.
Click the trash can in the
page header. This is not
undoable.
Click the small pencil icon
at the lefty of the Page
menu in the page header.

Select the page on the tree and click
Delete. This is undoable.
Select the page on the tree and click
rename.

⇑
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Item Palette

Item Palette
The item palette contains the Toot! fields or items.
• Visibility The palette is visible only in
design mode (use the popup menu, lower left
corner of every page).
• To place an item on a page, drag it from
the palette to the page and let go. Each item
holds a particular kind of data, or holds it in
a particular format.
• Exhibits: Six exhibit items hold artifacts of
different media:
– Graphics
– Movies
– Sounds
– Texts
– Web pages and
– External exhibits - any computer file
• Inspector: Each item has an inspector for
setting its properties and characteristics.
⇑
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Exhibits
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Exhibits
This Exhibit
External

Graphic

Movie
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Will
⇑ Open files or
documents created
in any program on
your computer.
Important: If
sending your
portfolio or résumé
out for review, be
sure the recipients
have the same
program or the
artifact will not
open for them.
Programs with
readers like .pdf
files or .wmv files
are good choices
because readers
are free.

Comments
Use external file exhibits for work
created in any software, spreadsheets,
slides, desktop publishing, authoring
stacks, word processing, programming
languages, CAD-CAM, draw, paint,
illustration,etc. The exhibit appears as
a button with the document’s program
icon. A copy of the original file is stored
in the portfolio bag; the original
remains on your disk. Clicking the
external exhibit button, launches the
original program and displays your
work. Especially good for PDFs,
Windows Media Player and other
non-QuickTime compatible media.
Browse: Add, view content; use the
Actions menu. To clear it, use Edit
menu. Design: Add/remove external
exhibit buttons and for field alignment,
prompt labels, etc.

⇑ Display images.

Double-click to see full size. Images
originate in digital cameras, scanners or
software; displays images supported by
QuickTime: typically bmp, gif, jpg,
Photoshop, pict, png, QuickTime, sgi,
Targa, and tiff. Browse: To add or
view content, use the Actions menu. To
clear it, use Edit menu. Design:
Add/remove exhibit frames, adjust
frame size, align on the page.
Supports all movie formats that
QuickTime can open. Create and/or
edit your movies externally before
making them an exhibit. For
non-QuickTime compatible movies, use
an external file exhibit. Browse: To
add or view content, use the Actions
menu. To clear it, use Edit menu.
Graphics may be cropped (see online
Help). Design: Add/remove exhibit
frames, adjust frame size, align on page.

⇑ Play video clips
(Must be
QuickTime
compatible; if not,
use the External
File Exhibit.)

800–774–7239

support@aurbach.com

Toot! Basics

Aurbach & Associates, Inc.

This Exhibit
Sound

Will
⇑ Record or import
sounds and play
them back

Text

⇑ Display styled text

Web Page

⇑ Launch your
browser and
display a web page

Text Items

Comments
Can record sound directly from the
computer’s microphone; also imports
sound files in a variety of QuickTime
supported formats. Be sure the sound
controls for input and output are set
correctly on your computer. If a sound
file not QuickTime compatible, use an
external file exhibit. Browse: To add
or view content, use the Actions menu.
To clear it, use Edit menu. Design:
Add/remove exhibit frames, align on
the page.
Type directly into the text box; or, cut
and paste text from the original
document; or drag and drop a plain text
(.txt) or rich text format (.rtf) file.
See also Text Items (below). Browse:
To add/view content, use the Actions
menu. To clear it, select text and use
the Backspace or Delete key. Design:
Add/remove exhibit frames, adjust
frame size, align on the page.
Requires a browser (Internet Explorer,
Netscape, Safari, Opera, Firefox...) on
your computer. Browse: To add a
URL (web page ID) use the Actions
menu. To view it, click the URL. To
clear it, use the Edit menu. Design:
Add/remove exhibit, adjust frame size,
align on page.

Text Items
This Item
Bullet List

Toot! Basics
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Will
Format text as an
indented bullet
list.

800–774–7239

Comments
Suggested Uses: Any brief
list. . . projects, references skills and
strengths. Browse: Add/ remove bullet
points on the Actions menu. Empty
bullets are pink. Design: Choose
bullets, check-marks, asterisks, hands,
arrows, or pointers. See also:
checkboxes, popup menu, radio buttons.

support@aurbach.com
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Text Items
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This Item
Experience
List

Will
Provide a
résumé-like format
for an employment
history

⇑

Paragraph

⇑

Provide a large,
unscrolled place to
enter styled text
directly on the
page

Text - Long

⇑

Provide a scrolled
box for entering
plain text

Text - Short ⇑

Provides a box for
entering brief text

800–774–7239

Comments
Each entry of the experience list has
two parts: a top of several brief lines in
bold font (recommended for dates,
company name, job title, and the like);
and a bottom, a paragraph (any length)
to describe the situation further. Use
the Text or Format menus to style text.
Browse: Enter work history
information; get new entries on the
Actions menu; empty entries (before you
type in them) are two shades of pink,
indicating the two parts. Design: If
you want words such as Experience, as a
title, enter them on the inspector
prompt line. In design mode, an
experience list looks like a grey
rectangle.
Holds approximately 10,000 words per
page. Browse: Appears pink when
empty. Type directly on the field.
Design: Change the width (height
depends on the amount of text.) See
also: Bullet List, Experience List, Text
Exhibit Tip: If you have a large amount
of text and need scrolling, use a Text
Exhibit, or an External File Exhibit.
It will hold 5000-6000 words. Browse:
Enter text, scroll to read it. This field
does not open in a larger window.
Design: Size the field, give it a title on
the inspector prompt line. See also:
Bullet list, exhibit - text, paragraph,
text short.
It will hold up to 256 characters.
Browse: Enter text up. Design: Size
the field, give it a title on the inspector
prompt line; set multi-line or required.
See also: Bullet list, exhibit-text,
paragraph, text long

support@aurbach.com
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Items for Options and Choices

Number Items
This Item
Date Field

⇑

Decimal Field⇑

Integer

⇑

Will
Provide a place to
enter or emphasize
a date

Provide a place to
enter a decimal

Provide a place for
a whole number.

Comments
Accepts only dates and will turn red if
non-dates are entered. Can show time
including seconds. Browse: Enter a
date. Design: Use the prompt on the
inspector to tell what the date signifies.
Accepts only numbers and will turn red
if alpha characters are entered.
Browse: Enter a number as a decimal.
Design: Use the prompt on the
inspector to tell what the it signifies; set
the number of decimal places on the
inspector.
Accepts only whole numbers. Browse:
Enter the numbers in browse mode.
Design: Label it using the prompt on
the inspector.

Items for Options and Choices
This Item
Check Boxes ⇑

Will
Provide a list of
items with boxes
for checking; check
as many as
needed.

Popup Menu ⇑

Provide a list of
choices in a menu
format; select one;
see only that one
Provide a list of
choices; select one;
see all.

Radio Buttons
⇑

Toot! Basics
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Comments
Suggested Uses: Use it to emphasize
things you have mastered or
accomplished: languages, skills,
strengths; or, for your own purposes, it
might be a to-do list, with items checked
as you finish them. Browse: Check all
the boxes to show your mastery of
everything on the list. Design: on the
item inspector, list the things to be
checked. Use the prompt to identify the
group of items; e.g., Fluent Languages
as the prompt; and French, Arabic, etc.
as the buttons. See also: bullet list
Browse: Choose an item on the menu.
Design: Enter the menu choices on the
inspector. See also: bullet list
Browse: Choose an item by clicking its
button. Design: Enter the button
choices on the inspector. See also:
bullet list

support@aurbach.com
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Special Items

Aurbach & Associates, Inc.

Special Items
This Item
Custom Help

Decorative
Box, Line ⇑

Decorative
Caption
⇑

Mail-To

10

⇑

Will
Provide additional
instructions,
information, notes,
reminders. . .
Note: Custom help
buttons are magenta
and go on the page.
Program help
buttons are blue in
page headers.
Help with
formatting

Create a headline or
a few words of text
sitting on the page

Provide a place for
an eMail ID and
launch your mail
program when
clicked

800–774–7239

Comments
Suggested Uses: If sending your Toot!
file out for review, you might put a Read
Me caption on custom help so you can
give instructions or comments, perhaps
in another language. Browse: Click the
button to see the text. Design: Enter
the text on the inspector’s Edit Custom
Help editor.

Suggested Uses: Group or separate
things on the page. Browse: View only.
Design: Drag the box to stretch it
around other items to group them. Use
the prompt on the box inspector to label
the group. To make a line vertical , drag
one end taller than it is wide.
Suggested Uses: For headlines, big
bold words on the page, your name, or
purpose of the page. All the Firstname
Lastname headlines on templates are
decorative captions. Change it to your
name by changing the prompt line in
Design mode. Browse: Read only.
Design: Set the font. Enter the text on
the prompt line on the inspector. See
also: Paragraph and Bullet List for
similar effect.
Use it to provide your eMail ID for
portfolio, CV and résumé reviewers
Browse: Use the Actions menu to enter
an email address; click the email ID to
launch the mail program. To clear, select
the mail-to field and choose clear on the
Edit menu. Design: Stretch the field to
hold long IDs.

support@aurbach.com
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This Item
Table

⇑

Will
Provide a tabular
format for
information

Item Inspector

Comments
Data can be text, integers, decimals,
checkboxes, dates or links to other pages.
Numeric columns can show a total,
average, count, or minimum and
maximum. Browse: Enter data,
rearrange rows; resize columns by
dragging vertical bar in header. Design:
Define columns on the inspector. Set
column type, size etc. on the inspector.

Item Inspector
The item inspector defines field properties including fonts, the items on pop up menus,
check boxes and radio buttons, field labels (prompts), and visibility. The inspector is
used in conjunction with the item palette. After you drag a field from the palette to a
page, set its properties on the inspector. The inspector for each field varies.
To see the item inspector:
1. Switch from browse to design mode (popup menu, lower left of the page).
2. Double-click any item on the page. If you don’t see it, look on the Window menu.

⇑
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Color
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Icons and Buttons
Click This

To Do This
Open Toot! online help.
Move to another page in the portfolio. See Links
Create a new page in this section.
Print this page.
Rename this section or page.
Delete this page.
Sound Note: double-click to listen.
Text Note: double-click to read.

⇑

Color
Toot is purposefully a quiet program because the excitement and flash should come
from you and your artifacts. Color is used in three places: alerts, borders and fonts.
Alert
Color

Border
Color

Font
Color

12

The default alert color is red; change it in Preferences. Empty
Bullets and paragraphs display the alert color which disappears when
you type on them. Checkboxes, popup menus and radio sets are red
when they have no items to check, pop or set. Correct them by
adding buttons on their inspectors in design mode.
• Choose a border color when creating a new portfolio but note that
it applies to new pages only (not existing pages in a template.) Or,
choose a color for new pages, via Options Menu, Portfolio
Maintenance.
• Change the border of the current page in design mode, Tailoring
Menu.
Rich-edit fields: For bullet lists, experience lists, paragraphs and
text exhibits, set font color in Browse on the Format or Edit menus.
Other fields: For everything else, including prompt titles on
rich-edit fields, font color comes from the data and prompt fonts
chosen on each field’s item inspector and those choice come from
your named fonts. See Fonts.

800–774–7239

support@aurbach.com

Toot! Basics

Aurbach & Associates, Inc.

Packaging: eMail vs DVD vs HTML

Fonts
Toot! uses fonts for prompts and data that have been named on the fonts panel.
To Do This
1) Set up a
Font

Follow these Steps
In Browse mode:
1. Open Options menu,
Portfolio Maintenance.
2. Click Edit Font List.
3. Click Add.
4. Give the font a descriptive
name and set its
characteristics. When Done,
the name will appear on the
Item Inspector font menus.

Comments
Toot! ships with some basic
Arial and Times fonts
already set up (because of
their universal availability).

2) Choose a
Font on the
Item
Inspector

1. Switch to Design mode.
2. Double-click a field on the
page to see its item inspector.
3. Set the Font menus.

This applies to most fields
and field prompts (or
labels). Note: The text in
rich text fields – bullet lists,
experience lists, paragraphs
and text exhibits – get font
characteristics from the
Format or Text menu.

⇑

Packaging: eMail vs DVD vs HTML
Toot! can help when you are ready to send your résumé, CV or portfolio out for review
to apply for a job, submit for professional certification, fulfill homeschool requirements,
or simply share with friends and colleagues. You can send the entire portfolio or export
relevant pages.
To
Prepare

Toot! Basics
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Do This
1. Review the Checklist for
Packaging the
Portfolio/Résumé in the
Toot! online help.
2. To send selected pages
for review, Export them.
[This is on the Options
menu.]

800–774–7239

Comments
• The Checklist has basic
reminders that everyone should
double-check prior to sending out
a résumé, CV or portfolio.
• Export: You don’t need to show
everything in your Toot!
portfolio. You can select
particular sections or pages and
export them to create a sub-set of
pages for review. eMail, burn or
convert the exported portfolio.

support@aurbach.com
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Packaging: eMail vs DVD vs HTML

To
eMail It

⇑
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Do This
1. In Browse mode, choose
Options Menu, Package
for eMail.
2. Follow the on-screen
instructions.

Burn to
CD-ROM
/ DVD
⇑

1. In Browse mode, choose
Options Menu, Package
for CD-ROM.
2. Follow the on-screen
instructions.

Convert to
HTML for
Web
Posting ⇑

1. In Browse mode, choose
Options Menu, Package
for the Web.
2. Follow the on-screen
instructions.
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Comments
• Toot! compresses the portfolio so
it can be attached to an eMail.
• eMail is quick.
• Be sure to give the Tooter link in
your cover letter so reviewers can
open your attachment:
http://www.aurbach.com/Toot/
Tooter.html.
• Keep it small – one or two
artifacts because most eMail
systems limit the size of the files
they will handle. Stay under
2MB. (Show them more of your
work at the interview.)
• Toot! creates a burn folder with
your portfolio and bag. It does
not do the burning; you need
additional hardware and software
to burn a CD or DVD.
• Get Tooter and add it to the burn
folder (http://www.aurbach.
com/Toot/Tooter.html)
• Toot! will convert your portfolio
to html so you can post it on a
website. Each page of the
portfolio-resume will be one web
page. Tommy’s portfolio is an
example of this.(http://www.
aurbach.com/Toot/pf-1.html)
• Tooter is not needed to view it.

support@aurbach.com
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Tooter

Layout
To:
Add Fields
to a Page ⇑

Do This:
1. Switch to design mode (popup menu, bottom left).
2. From the item palette, drag a field to the page. No palette?
Choose it on the Window menu.
3. Double-click the item to see its item inspector and fill in the
inspector properties for the item which differ from item to item.
No inspector? Select the item and choose item inspector on the
Window menu.

Add
Content to
Fields

• Exhibits: In browse mode, drag the appropriate media to an exhibit; or, select the exhibit and choose the top item on the Actions
menu.
• Bullet lists, experience lists: Use the Actions menu to add items
to the list; type in the new items which are pink to indicate they
are empty.
• Other fields: Place the cursor and type In the online tutorial, this
is Filling the portfolio.
• In design mode, Select two or more fields.
• Choose Align-Distribute on the Tailoring menu.
• In design mode, select a field to copy.
• On the Tailoring menu, choose Duplicate. It will create an exact
copy of the first field, meaning it will have the same prompt and
if there was any content in the field, it will have the same content.
• Open the item inspector for the copy and change its prompt text
to distinguish between the two.
• Drag the duplicate to its place on the page; replace the content, if
any was there.
This removes a field and its content from the page:
• In design mode,select the field.
• Click Backspace or Delete.
• In design mode, select the field. (Blue "handles" appear, indicating it is the active item.)
• Drag the field to its new position. Use the keyboard arrow keys
to move it one pixel.
• In design mode, select the field.
• Drag a blue handle to stretch/shrink the field. Or, Double-click to
see the field’s item inspector and change the number of pixels in the
Height and Width properties. If they are missing on the inspector,
open general preferences and choose Show All Attributes.

Align
Fields
Copy/
Duplicate a
Field
⇑

Delete a
Field
Move a
Field

Resize a
Field

⇑

Tooter
TooterTM is the Toot! viewer, free at www.aurbach.com. If you send your portfolio or
résumé out for review, the recipient needs a way to open it. Using Tooter is analogous
to using Acrobat Reader to open a PDF file; it lets people view but not change your
portfolio or résumé.

Toot! Basics
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Selected Toot! Terms

eMail:
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If you email your Toot! portfolio or résumé, be sure to tell the recipient
how to get Tooter at http://www.aurbach.com/Toot/Tooter.html.

CD/DVD: If you burn your portfolio or résumé to a CD or DVD, place a copy of
Tooter in the burn folder.
⇑

Tips for Résumés and CVs
 Keep résumés and CVs brief. Include only one, maybe two artifacts, never more
than three. One is fine.
 Choose the artifact carefully; it should be something that shows mastery of your
profession and/or your ability to communicate in writing or speaking. If you are
just starting out in your career, include a single artifact that shows your ability
to communicate.
 Always include a reflection with the artifact. The reflection is where you explain
the importance of the artifact; put it in context, tell why you are including it,
what it shows about your abilities; what you learned from doing it. The Toot!
online help and our essay, About Portfolios contain suggestions about reflection.
⇑

Selected Toot! Terms
Actions Menu The actions menu is relevant for certain items in browse mode and
it activates only when one of them is selected. The exhibit items, bullet lists,
experience lists, paragraphs and tables all use the actions menu.
Bag The exhibits for your Toot! portfolio are stored in a folder with the portfolio name
and a .bag extension; we call it a bag (it’s just a folder). When you add an exhibit,
Toot! places a copy in the bag. The original remains on your drive. When you
open an exhibit, it is linked to the one in the bag and that’s one you see. Keep
your bag. It needs to go with your portfolio - résumé when you package it for
distribution.
Exhibit Toot! stores artifacts as one of six media or exhibits: graphic, sound, movie,
text, web, or external exhibit. An external exhibit is any document created with
any software.
Expired demo The Toot! demo is good for 30 days. During that time, most features
are available and you can build a portfolio or résumé with your artifacts; however,
you will not be able to export pages or package it for dissemination. After 30
days, you can page through your portfolio, but all features will be turned off. To
purchase, open the Options menu.

16
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Selected Toot! Terms

Export You might want several versions of your portfolio for different purposes, perhaps for applying for jobs in different fields. Or to keep your personal portfolio
with everything in it and export certain pages, to make a subset portfolio for
submitting to licensing agencies, fulfilling job requirements, etc. If you need more
than one version of your portfolio, export it:
1. On the Options menu, choose Export.
2. Click on the tree-view to choose which sections and pages go into the export
version. If you select pages without a section, the program will pick up the
section name for them.
• On Windows, click and re-click to check and uncheck.
• On Mac, click to check an item, Command-click to uncheck.
3. Click Export.
4. Name the new file or the program will call it MyExportPortfolio.toot. You
can change that name, but do keep the .toot suffix. The file will have this
name (to distinguish it from the original), but when you open the portfolio
it will retain your name in the header.
5. Choose where to place it and click Save.
6. Look for the exported portfolio in the My Documents or Documents (or other
place that you saved to).
Link A link is a cross-reference between two pages within the portfolio, similar to a
hyperlink on the internet. Links may be embedded in tables, experience lists and
bullet lists or they can be standalone. A standalone link starts like a posted note:
1. If Windows, Control-click on the page;
if Macintosh, Option-click on the page.
2. Choose Card Link.
3. Select a page on the tree-view. Close the tree-view window and the link will
identify the linked page.
Package Your Toot! portfolio - résumé can be packaged three ways for sending to
someone else, eMail, CD-DVD, or HTML for web posting. Those who receive it
— prospective employers, mentors, friends,professional or educational reviewers
can use Tooter, the free Toot viewer, to open it. See also Packaging.
Portfolio vs Résumé/CV The difference is chiefly in purpose. If you are looking for
a job is most careers, it’s probably a CV or a resume. For an artist, performer or
educator, it’s likely to be a portfolio. The difference between Toot! and a ‘résumé
builder’ is the inclusion of artifacts as part of the package.
Posted Note Create a “sticky” note on a page as a reminder to yourself, as a comment
to a viewer or to a link to another page within the portfolio. See link.
1. Place your cursor on a page, though not on a field, nor in the header.
2. For Windows control-click, for Macintosh option-click.
3. Choose Text Note or Sound Note.
4. Type in the text panel, record into the microphone.,
5. Close that panel and a tiny icon, like one of these for text or sound will be
on the page where you clicked at step 2.
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Preferences The location of Preferences menu item varies by operating system:
Windows:

Edit menu

Macintosh OS 9:

Edit menu

Macintosh OS X:

Toot! menu

Purchase To purchase Toot! choose Purchase on the Options menu. Thank you.
Select To select an item, click it once to place focus on it, in effect telling Toot! to
perform the next action on the selected item. For example, select an exhibit, then
open the Actions menu to do something with it. (Clicking twice usually causes
something else to happen.)
Template A template has two or three sections, each with several page layouts with
instructions on each page. Over 65 templates may be downloaded from http://
www.aurbach.com/download_tplAlpha.html. Most templates are geared to professions; however, there are others, notably Homeschool, Reflection, and generic
resumé/portfolio templates. You may create your own templates (Options menu,
Make a Template) for use by your students or by practitioners of a professional
association. If you prefer, Aurbach & Associates can create a template for you.
Send a query to sales@aurbach.com.
Tree-View Tree-view is a dynamic
outline of the sections and pages
in the portfolio. It appears in
Portfolio Maintenance (on the
Options menu), and when you
create a link. The view changes
on the fly as you add, delete and
rename sections and pages.
Click the + and − buttons to
open and close sections and
see their pages.
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